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Trademarks 

Microsoft is a U.S. registered trademark of Microsoft 
Corporation. 
Windows and MS-DOS are trademarks of Microsoft Corporation. 
IBM, PC, AT, XT are registered trademarks of International 
Business Machines Corp. 
ENERGY STAR® is a U.S. registered mark. 
Other brands and product names herein are trademarks or 
registered trademarks of their respective holders. 

Copyright 

All rights reserved. No part of this publication may be 
reproduced, transmitted, transcribed, stored in a retrieval 
system, or translated into any language or computer language, 
in any form or by any means, electronic, mechanical, magnetic, 
optical, chemical, manual, or otherwise, without the prior 
written permission of Avision Inc. 
 
Material scanned by this product may be protected by 
governmental laws and other regulations, such as copyright 
laws, the customer is solely responsible for complying with all 
such laws and regulations. 

 

Warranty 

The information contained in this document is subject to 
change without notice. 
 
Avision makes no warranty of any kind with regard to this 
material, including, but not limited to, the implied warranties 
of fitness for a particular purpose. 
 
Avision shall not be liable for errors contained herein or for 
incidental or consequential damages in connection with the 
furnishing, performance, or use of this material.  
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FCC Radio Frequency Interference Statement  

This product has been tested and found to comply with the 
limits for a class B digital device, pursuant to Part 15 of 
the FCC rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any 
interference received, including interference that may 
cause undesired operation.   The FCC Class B limits are 
designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment 
generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or 
television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to 
correct the interference by one or more of the following 
measures: 

 Reorient or relocate the receiving antenna. 
 Increase the separation between the equipment and 

receiver. 
 Connect the equipment into an outlet on a circuit 

different from that to which the receiver is connected. 
 Consult your point of purchase or service representative 

for additional suggestions. 
 

 
CE Warning 

This product satisfies the Class B limits of EN55022, EN55024 
and safety requirements of EN 60950. 
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Disposal of Waste Equipment by Users in Private Union 

 

This symbol on the product or on its packaging indicates that 
the product can not be disposed of with your other household 
waste.  Instead it should be sent to appropriate facilities for 
recovery and recycling in an effort to protect human health and 
the environment.  Fore more information about where you can 
drop off your waste equipment for recycling, please contact 
your local city office, your household waste disposal service or 
the shop where you purchased the product.   
 
 
 

 As an ENERGY STAR® Partner, Avision Inc. has 
determined that this product meets the ENERGY STAR 
guidelines for energy efficiency. 
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1. Introduction 
 

 

 

Congratulations on your purchase of the document scanner. 

Before you install and operate the scanner, please take a 
few minutes to read through this manual. It provides you 
with the proper instructions on how to unpack, install, 
operate and maintain the scanner. 

Figure 1-1 shows how the scanner is packed.  You can 
check all items against your “checklist”, included with 
your scanner. 
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2. Installation 
 
 
Please unpack the scanner carefully, and check the contents 
against the checklist.  If any items are missing or damaged, 
please contact your authorized local dealer immediately. 

Precautions 

• Keep the scanner out of direct sunlight.  Direct 
exposure to the sun or excessive heat may cause 
damage to the unit. 

• Do not install the scanner in a humid or dusty place. 

• Use only the AC adapter (HEG42-240200-7L by 
Hitron) included with the machine. Using other AC 
adapters may damage the machine and void the 
warranty. 

• Place the scanner securely on an even, flat surface. 
Tilted or uneven surfaces may cause mechanical or 
paper-feeding problems. 

• Retain the scanner box and packing materials for 
shipping purposes. 

2.1 Unlocking the Shipping switch 

The scanner has a shipping switch that locks the carrier 
mechanism for transportation purposes.  This switch must 
be unlocked before using the scanner. 

Before proceeding, turn the power off, disconnect all cables 
and follow the instructions below to unlock the shipping 
switch. 
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2.1.1 unlocking the scanner 

 
i). Carefully place the scanner in an upright position on 

its front. 

ii). Unlock the scanner by moving the lock switch beneath 
the scanner to the “Unlock” position (See Figure 2-1). 

iii). Gently place the scanner back to its normal position. 
 
 
 
 

  
 

Figure 2-1  Unlocking the Shipping Switch
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2.1.2 locking the Shipping switch 

 

 
Whenever you need to move the scanner to a new location 
it is advisable to lock the shipping switch to avoid causing 
damage to the scanners’ internal mechanism. Please follow 
the instructions below to lock the shipping switch. 

 

1). Turn off the scanner. 

2). Lift the Document cover to reveal the flatbed glass and 

scanning unit. 

3). Turn on the scanner. 

4). Turn off the scanner again while the scanning unit 

moved to the end for a few seconds. 

5). Place your scanner in an upright position on its front 

side. 

6). Lock your scanner by moving the lock switch to the 

"Locked position".  

7). Place the scanner back to its normal position.   
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2.2 SCSI ID 

 
 
When you have several devices on a SCSI chain, you may 
need to adjust the SCSI ID selector setting located on the 
back of the scanner. This setting assigns a specific "device 
ID" to the scanner.  If the assignment conflicts with an 
existing SCSI device, please select a new ID. (See Figure 2-
2) 

Note: The factory setting for scanner is ID 6.  Usually, ID 0 is 
assigned to an internal hard disk drive, and ID 7, ID 8 ,and 
ID 9 are not in actual use. 

Using a suitable tool, turn the selector switch until the arrow 
points to the desired ID number. 

2.3  Setting SCSI Terminator  

The scanner is equipped with a built-in terminator switch on 
the rear of the scanner. (See Figure 2-2). The scanner is 
equipped with a built-in terminator switch on the rear of the 
scanner. Turn the terminator switch on if the scanner is to be 
connected to the computer as the only or the last SCSI 
device. Turn the terminator switch off if the scanner is to be 
located between the computer and the other SCSI device. 
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Figure  2-2 Adjusting the SCSI ID setting 
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2.3 USB Interface 

Note that the machine is designed with two ports, SCSI and 
USB, to connect with the computer.  If you are using the 
USB port, be sure to install the scanner driver before 
connecting the USB cable to your computer.  Otherwise, the 
scanner may not work properly.    

2.4 ADF Paper Chute 

i). Lift the paper chute to about 45 degrees.  

ii). Pull the paper-chute wire leg down to the grips on the 

document cover. 

iii). Slightly press the paper chute to snap the wire leg 

into the grips on the document cover. 

iv). Pull out the paper chute extension to the length you 

want. 

 

 

 

Figure 2-3 Setting the ADF 

Paper Chute 
Extension ADF Paper Chute 

Paper Chute 
Wire Legs 
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2.5 ADF Output Tray  

 
i). Hold the output paper tray some 30 degrees aslant as 

shown in Figure 2-4. 

ii). Insert the three protrusions on the output paper tray 

to the three slots on the ADF. 

iii). Release the paper tray gently. Make sure the tray is 

firmly attached to the ADF.  

iv). Pull out the output paper tray extension wire to the 

desired length. 

 

 

    

 

Figure 2-4 Install the ADF Output Paper Tray 

Output Tray 
Extension Wire 



 

 2-8

 

2.6 Document Loading 

 

 

For flatbed scanning 

 

Documents that can not be scanned using the ADF can be 

placed on the flatbed for scanning.  (See Figure 2-5) 

 

i). Place the document to be scanned onto the document 

glass face down. 

ii). Position the document so that the upper-right 

corner is aligned with the reference mark. 

 

 
 

Figure 2-5  Place Document on the scanner 
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2.7 ADF Scanning 

 
 
Multiple documents can be fed automatically using the ADF.  
Refer to Figure 2-6. 

 

i). To prevent occasional paper jam when automatically 
feeding multiple documents, fan the paper before 
loading. 

ii). Lift the balance wire. 

iii). Place the documents onto the ADF paper chute in 
either paper side (face-down, face-up), with the 
leading edge in the auto feeder entrance.   

     Let the balance wire rest on the top of the documents. 

iv). Adjust the left and right guides so that they are snug 
against the sides of the documents. 

 

 

 
 

Figure 2-6  Loading Multiple Document 

 

Balance Wire

Paper Guide 
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2.8 Connecting the Cable 

 

i). Turning the Power Off 

Depress the side marked “O” to turn the power off. 

Connect the power cable and SCSI signal cable as shown 
in Figure 2-7. 

ii). Turning the Power On 

Depress the side marked “I” to turn the power on. The 

POWER LED will light. If not, please check the power 

source. 

iii). SCSI Termination/USB Port 

The scanner is designed with both the USB and SCSI port.  
If you wish to connect the scanner with a USB port, please 
install the scanner driver first and then connect the USB 
cable.  If you wish to connect the scanner with SCSI port, 
please note the following: 

The scanner comes complete with a built in SCSI 
terminator.  If the scanner is the last device in a SCSI 
chain, the terminator should be switched on. If the 
scanner is not the last device, the terminator should be 
off. The terminator on/off switch is located on the back of 
the scanner, to the left of the SCSI cable connectors. 
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Figure  2-2 Terminator ON/OFF 
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Figure 2-7  Cable Connection 
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3. Requirements & software 
installation 

 
 
To run the scanner at rated speed recommended, you must 
have the following minimum requirements: 
 

• IBM compatible PC 586, Pentium or higher 

• Microsoft Windows 95 /NT/98/98SE/Me/2000/XP 

• One SCSI card installed on your computer; or a USB port 
on your computer 

• 100M bytes of available hard disk space for installation; 

• 128M bytes of RAM 

• A CD-ROM drive. 

 

3.1 Scanner Driver Installation 

 
Important! 
If you wish to connect the scanner with a USB port, please 
install the scanner driver first and then connect the USB cable. 
 
1. Start your PC and Windows application. 

2. Insert the scanner bundled CD to your CD-ROM drive. 

3. The software installation graphic should appear as 
below: 
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If not, press the Start button, choose RUN,and type 
d:\driver\twain driver (or ISIS driver)\setup.exe (d means the 
letter indicating your current CD-ROM drive). Click on the OK 
button. 
 
4. Follow the subsequent instructions on the screen to 

complete the driver and application installation.  
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3.2 Verifying Your Scanner Installation   

 
To verify if your scanner installation is correct, Avision provides 
you a useful test program called Avision Capture Tool.  With 
this tool, you can perform simple scans and view the captured 
images.  In addition, it helps you complete your scan at a rated 
speed. 
 
The following procedure describes how to verify your scanner 
installation.  If the installation is not correct, please review the 
preceding section to check if the cable connection and scanner 
driver have been successfully installed.    
 
Before you begin, be sure the scanner is on. 
 
1. Select Start>Programs>Avision AVxxx Scanner>Avision 

Capture Tool. 
The Select Scanner Model dialog box will be displayed.  

 
 

2. Select your driver type and scanner model and click OK.  
The following Avision Capture Tool dialog box will be 
displayed. 
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3. Choose your desired file format from the File Format drop 
down list box. (Default is BMP, other choice includes TIFF, 
GIF, and JPEG.) 

4. Type your desired folder name and file name in the File 
Path box. (Default is C:\My Scan\Image.) 

Note: If you do not wish to save the scanned image, 
deselect the Save button since default is Save Enable. In 
this case, the thumbnail view will be disabled.  And 
therefore, after viewing all the scanned images, only the 
last one will remain on the screen.   

5. Click the Setup button ( ) or choose Setup from the 
File menu to prompt the Scanner Properties dialog box. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Setup   

Actual  
Size 

Fit 
Page 

Scan 
File Format 

Save       File Path 
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6. From the Image Selection Box, choose your desired image 

type for your scanned image.  (Default is Front B&W)  If 
you have a duplex scanner, choose Front and Rear to scan 
both sides of your document.  

7. Click OK to quit the Scanner Properties dialog box.  (To 
learn more details about the Scanner Properties dialog box, 
please see the subsequent chapter, Using the Scanner 
Properties Dialog Box.) 

8. Place your document face down on the document glass or 
face up in the auto document feeder. 

9. In the Scan Validation dialog box, click the Scan button 

( ) or choose Scan from the File menu. 

10. The document will be scanned and displayed in the Scan 
Validation screen.  After the scanned images have been 
displayed, your scanner installation verification is 
completed.  

Image 
Selection 

Box 
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11. You can view the scanned image in Fit Page ( ) or 

Actual Size (100%) button ( ) from the Viewing toolbars 
at the right side. 

12. Click the Close box or Quit from the File menu to exit the 
Scan Validation Tool. 

 

 

Fit Page View Status Bar 
Thumbnail View 
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3.1.1 A Glance of the Scanner Properties Dialog Box 
 

 
 
1. Tab Options Choice:  Image, Compression, Color Dropout, 

Paper, Options, Settings, Information. 
2. Image 

Selection Box 
Choose your image type and the side of 
document you wish to scan.  Options vary 
based on type of scanner.  

3. Brightness: Adjust the brightness level from –100 to +100.  
4. Contrast Adjust the contrast level from –100 to +100. 
5. Resolution Determine the quality of the scanned image.  

The industry standard is 200 dpi. 
6. Invert Reverse the color of your scanned image. 
7. Scan Source  Choice: Auto Document Feeder, Flatbed, 

Flatbed (Book), Automatic (varies due to 
different scanner model)  

8. Defaults Reset all values on the tabs to the factory 
default settings. 

 
    

3 
4 
5 
6 
 
7 

1 

 

2 

8 
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4. Using the Scanner 
Properties Dialog Box  

 
 
 
The Scanner Properties dialog box allows you to configure the 
scanner’s settings. It consists of several tabbed windows each 
of which will be described in this chapter. 
 

 
 

The Scanner Properties dialog box 
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4.1 Buttons on the Scanner Properties Dialog Box  

 

The buttons on the Scanner Properties dialog box 
 

Buttons Description 

Defaults Click the Defaults button, the factory default 
settings will be shown on each tab.   

Scan After all the scan settings are satisfactory, click 
the Scan button to start scanning your 
document. 

Close Click the Close button to leave the Scanner 
Properties dialog box. 
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The following table shows the default settings： 
 
Tab name Default settings 
Image Image：Front B&W 

Binarization：Dynamic Threshold 
Resolution：200 dpi 
Invert：Blank on White 
Scan Source：Auto Document Feeder 
Threshold：None 
Brightness：None 
Contrast：None 

Compression None 

Color Dropout None 

Paper Cropping：Automatic 
Deskew：Yes 
Orientation：Portrait 
OverScan：0.00  
Multifeed Detection：None 
Unit：Inch 

Options Rotation Degrees：None 
Blank Page Removal：None 
Edge Fill：White，0 mm 
Image Control Option：None 

Setting Enable Energy Saver：Enable, 15 
minutes after last scan action 
Show Scanning Progress：Yes 
Show Warning Message：Yes 
Save Settings after Closing：Yes 
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4.2 The Image Tab  

The Image tab allows you to choose the front side and (or) the 
rear side of your document, the type of image, and to set 
several basic scan settings.  Note that except for the resolution, 
you can set individual scan settings for the front side and the 
rear side.  For example, all settings in the Image tab, 
Compression tab, Color Dropout tab can be set individually for 
the front and the rear side.  However, the settings in the Paper 
tab, the Option tab, and the Setting tab have to be set the 
same for the front and rear side.   
 

 
 

The Image tab dialog box 



 User’s Manual 

 4-5

 

4.2.1 The Image Selection Box 

 

The Image Selection box includes 
the image type and document side 
option.  If you wish to scan both the 
front side and the rear side of your 
color document, you can check both 
Front Color and Rear Color at the 
same time.  Note the options vary 
based on type of scanner. 

 
Example 1：Scanning a two-sided color document, both 
sides in color 

 

Side/Image 
Selection 

 
Front  

Rear 
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Example 2：Scanning a two-sided color document, one 
in B&W(Drop Blue Color：Threshold：10, Background：
79), the other in color 

 

 

Side/Image 
Selection 

 

Front 

 

Rear 

 

Image Type Description 
Color Choose Color if you wish to scan a color 

image for your original in color.  
Gray Choose Gray image if your original contains 

actual shades of gray. 
B&W Choose B&W if your original contains only text

pencil or ink sketch. 

   
B&W Gray Color 
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4.2.2 Other Image Options 

Binarization This is the process of converting a 
grayscale or color image to a bi-tonal 
image. There are several different 
methods of performing this conversion.  
Two of the options are Dynamic 
Threshold and Fixed Processing. 

Dynamic Threshold:  Selecting 
Dynamic Threshold allows the scanner 
to dynamically evaluate each document 
to determine the optimal threshold value 
to produce the highest quality image.  
This is used to scan mixed document 
containing faint text, shaded background, 
or color background with a single setting.  
If Dynamic Threshold is selected, 
Threshold, Brightness, and Contrast are 
not available. 
 
Fixed Processing:  Used for black-and-
white and other high contrast documents.  
A single level is set to determine the 
black-and-white transition. The threshold 
is programmable over the entire density 
range.  Fixed Processing sets Contrast 
to 0.  If Fixed Processing is selected, 
Contrast is not available. 
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Threshold Used to convert a grayscale image to a  

bi-tonal image. The value ranges from 0 to 
255. A low threshold value produces a 
lighter image, and can be used to subdue 
backgrounds and subtle, unneeded 
information. A high threshold value produces 
a darker image, and can be used to help pick 
up faint images.  
Adjust the threshold setting by dragging the 
Threshold sliding bar to the left or right to 
achieve the desired threshold setting. 
 

 
 
200 dpi, 
Threshold:80, 
Brightness: 0 

 
 
200 dpi,  
Threshold:170, 
Brightness: 0  
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Brightness Adjusts the lightness or darkness of an 
image.  The higher the value, the brighter 
the image.  Drag the slider to the right or 
left to increase or decrease the brightness.  
The range is from –100 to +100. 

Contrast Adjusts the range between the darkest and 
the lightest shades in the image.  The 
higher the contrast, the bigger the different 
grayscale. Drag the slider to the right or 
left to increase or decrease the contrast.  
The range is from –100 to +100. 
 

   
Brightness: -50 Brightness: 0 

(Normal) 
Brightness: +50 

   
Contrast: -50 Contrast: 0 

(Normal) 
Contrast: +50 
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Resolution A good control of the resolution results a 

good detail of an image that scans.  The 
resolution is measured by dots per inch 
(dpi).  Normally, the greater the dpi number, 
the higher the resolution and the image file 
size.  Be aware that greater resolution takes 
more time to scan, and more disk space for 
the scanning image.  For your information, 
an A4 size color image scanned at 300 dpi at 
True Color mode consumes approximately 25 
MB of disk space. A higher resolution 
(usually means over 600 dpi) is only 
recommended when you need to scan a 
small area at True Color mode.  

Choose a resolution value from the drop 
down list. The default value is 200 dpi. 
Available resolutions are 75, 100, 150, 
200,300, 400 and 600. Or you may choose 
your desired value by clicking the box in the 
right side of the drop down list and press the 
arrow key to select your desired value and 
then click the Add button to include it in the 
drop down list. 

 
Resolution: 75 dpi  

Resolution: 150 dpi 
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Invert Reverses the brightness and the colors in the 

image.  The default setting is Black on a White 
background.  Reverse mode is White on a Black 
background. For color images, each pixel will be 
changed into its complementary color at the 
command of Invert. 
 

 
Black on White 

 

 

White on Black  
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Scan 
Source 

Choice: 
 Auto Document Feeder:  Used to scan 

multiple pages. 
 Flatbed:  Used to scan a single page. For 

example, pages from newspaper clipping, 
paper with wrinkles or curls.  

 Flatbed (book):  Used to scan several 
inside pages from book. 

 Automatic:  Allow the scanner automatically 
set its scan source.  If Automatic is selected 
and there is document in both the auto 
document feeder (ADF) and the flatbed, then 
the scan source will be automatically set to 
ADF.  If Automatic is selected and there is 
document only in flatbed, then the scan 
source will be set to flatbed. 

 
Note the options vary based on type of scanner. 
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Color 
Adjustment 

 

Adjusts the color quality of the image so 
that it comes close to that of the original.  
This function uses default parameters to 
adjust the image. 

 

            
                        Normal 
 

           
                 After Color Adjustment 

 
 
 
 

4.2.3 Scanning color images 

The following options are available for scanning color images.  

 Brightness 
 Contrast 
 Resolution 
 Invert 



 

 4-14

4.2.4 Scanning grayscale images  

The following options are available for scanning gray images.  

 Brightness 
 Contrast 
 Resolution 
 Invert 

  

4.2.5 Scanning B&W images  

The following options are available for scanning B&W images.  

 Binarization (Dynamic Threshold) 
 Resolution 
 Invert 
 

Or 
 Binarization (Fix Processing) 
 Threshold 
 Brightness 
 Resolution 
 Invert 
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4.2.6 Editing Profiles 

 
The Scanner Properties dialog box allows you to change and 
save your frequently used scan settings into a profile.  You can 
edit these profiles by renaming or deleting them.  
 
To add a new profile, 
 
1. Customize your settings.  (For example, change your 

resolution, image type, cropping method, scan size, or 
other scan settings.)  

2. Click the Image tab and then choose “Profiles” to prompt 
the “Edit Your Profile” dialog box.  

 
 
3. Click “Add” to enter the name of the profile and then 

choose “Save”. 

 
 
4. The new profile will be saved and shown in the “Profiles” 

dropdown list box.  
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To load a profile,  
 
 
1. From the Image tab dialog box, choose your favorable 

profile from the “Profiles” dropdown list box. 

 

2. Your favorable profile will be immediately loaded and 
displayed on Scanner Properties dialog box. 

 
 
To delete a profile, 
 
1. From the Image tab dialog box, click “Profiles” to prompt 

the Edit Your Profile dialog box. 

 
 
2. Choose the profile you want to delete from the dropdown 

list box. 
3. Click “Delete”.  A Confirm message “Are you sure you 

want to delete this profile?” is prompted. 
4. Choose “Yes” to delete or “Cancel” to quit. 
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To rename a profile, 
 
 
1. From the Image tab dialog box, click “Profiles” to prompt 

the Edit Your Profile dialog box. 

 
 
2. Choose the profile you want to rename from the dropdown 

list box and then click the Rename button. 
 
3. Enter new name for the profile. 

 
 
4. Choose “Save” to save the new profile or “Cancel” to quit. 
 
Note: 
The preset default profiles include Flatbed, Simplex-B&W, 200 
dpi, Simplex-Gray, 200 dpi, Simplex-Color, 200 dpi, Duplex-
B&W, 200 dpi, Duplex-Gray, 200 dpi, Duplex-Color, 200 dpi.  If 
you have a simplex or a sheetfed scanner, the duplex or the 
flatbed option will not be available. 
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4.3 The Compression Tab 

The Compression tab allows you to compress your scanned 
image and choose the level of compression.  Bi-tonal images 
are normally compressed using CCITT standard called Group 4 
(G4).  Color and grayscale images are often compressed using 
JPEG technology.  Move the JPEG Quality slider to the right or 
left to increase or decrease the level of compression.  Note the 
greater the compression level, the lower image quality.  Default 
is 50%. 

 
Note that the compression depends on your image editing 
application.  If your image editing application does not support 
the type of compression format, then  either a warning 
message will appear or the image quality of the compressed file 
will not be acceptable.  
 
JPEG (Joint Photographic Editor Group).  This group developed 
and lent their name to a file compression standard for color and 
grayscale images that is widely used by scanners, and software 
applications.  On Microsoft Windows-based systems, a file with 
the extension .jpg has normally been compressed using this 
standard. 

 
For scanning color or gray images, the following compressions 
are available: 

 None 
 JPEG 

 
For scanning B&W images, the following compressions are 
available: 

 None  
 G4 
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The Compression tab dialog box 
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4.4 The Color Dropout Tab   

4.4.1 Color Dropout Selection 

Color Dropout tab allows you to drop either of the red, blue, or 
green color in your scanned image.  If your image contains red 
color watermark or background, choose the R (Red) channel 
then any red watermark or background will be removed.  This 
feature is used to sharpen your text when using OCR (Optical 
Character Recognition) software.   

Note that this function supports only black & white and gray 
images.  Therefore, be sure to choose any black & white or 
gray image type while applying this function. 
 

 
 

The Color Dropout dialog box 
 



 User’s Manual 

 4-21

 

4.4.2 Other Color Dropout Options 

 
Advanced Processing provides two options that can adjust 
your scanned image in the best optimal result. 
 
Filter 
Threshold 

This value is used to determine the color 
which will be dropped out.  A lower value will 
drop more of the selected color out, while a 
higher value will leave more of the selected 
color in. 

Background 
Level 

The pixel which is higher than the 
background value will be adjusted to the 
lightest point.  Adjust the value for both the 
Filter Threshold and Background Level to 
produce the best optimal result. 
 

Example, slightly adjusting the background value makes 
your text more clear.  
 

 
Original 



 

 4-22

 
 
 

 
Remove Blue, Threshold: 20, Background: 
255 

 
Remove Blue, Threshold: 20,  
Background Level: 210 
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4.5 The Paper Tab  

The Paper tab allows you to define values relating to image 
output (i.e., Auto Crop or not, Scan Area, OverScan, Multi-Feed 
Detection).  
 

 

The Paper tab dialog box 
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4.5.1 Cropping  

Cropping allows you to capture a portion of the document 
being scanned.  Choice:  Automatic, Fixed to 
Transport, EOP (End of Page) Detection. 

 
Options Description 

Automatic Automatic adjusts the cropping window 
according to different document sizes. Use 
this option for batches of mixed-sized 
documents. 

Fixed to 
Transport 

This feature allows you to define the area 
or zone to be imaged.  Use for batches of 
same-sized documents.  If you select this 
option, you can use the arrow keys to 
define the x and y offset values, width and 
length to redefine your scanned area.  The 
Display window will show image placement 
as you change the values. 

EOP (End of 
Page) 
Detection 

This feature allows you to define the area 
or zone to be imaged.  Use for batches of 
same-width but different length 
documents.  If you select this option, you 
can use the arrow keys to define the x and 
y offset values, width and length to 
redefine your scanned area.  The Display 
window will show image placement as you 
change the values. 
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The following options are only available when Fixed to 
Transport is selected.  

 
 X-Offset — the distance from the left end of the 

scanner to the left edge of the scanning area.  

 Y-Offset — the position from the top end of the 
document to the top end of the scanning area.  

 Width — the width of the scanning area.  

 Length — the length of the scanning area.  

 Center: automatically calculates the x-offset for center-
fed feeding based upon document size selected. 

 — relocate the scan area by click the arrow key on 
the cross sign while retain the scan size.  View the result 
from the Display window.   
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Example： Redefine your scan area ( x-offset: 2.25 inches；y-
offset:1.13 inches) 
 

 
 

 
Original 

 

After Fixed to 
Transport 

 
 

Display  
window 

Scan 
Area 

The Redefined Scan Area 
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4.5.2 Other Paper Selection 

Deskew 

Use this option to automatically deskew a document.   

  
 
 
Scan Area  

Choose your desired paper size with the drop-down list box.  Or 
you may select a custom paper size by clicking the Scan Area 
box and then click Add to include in the choice. 

Choice:  None, US Letter- 8.5”x 11”, US Legal – 8.5” x 14”, 
ISO A4 – 21 x 29.7 cm, ISO A5 – 14.8 x 21 cm, ISO A6 – 10.5 
x 14.8cm, ISO A7 – 7.4 x 10/5 cm, ISO B5 – 17.6 x 25 cm, 
ISO B6 – 12.5 x 17.6 cm, ISO B7 – 8.8 x 12.5 cm, JIS B5 – 
18.2 x 25.7 cm, JIS B6 – 12.8 x 18.2 cm, JIS B7 – 9.1 x 12.8 
cm, Scanner Maximum, Long Page. 

 
Long Page:   
When you need to scan documents whose length exceeds 
scanner maximum, please choose Long Page.  Note if Long 
Page is selected, the Multi-Feed Detection will not be available. 
Options: Unknown Length, Enter Length   (Note: This option 
varies due to type of scanner.)   
 

Note: If the skew angle is 
too great, some of the 
image may be cut off. 
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Choose “Unknown Length” if you have a batch of long page 
document with unknown length. Choose “Enter Length” to 
enter the length and width of your documents or your desired 
scan size on documents.  This is useful when you have a batch 
of documents with the same scan size or a batch of same-sized 
documents. 

OverScan 
Overscan allows you to add a specific margin at top and bottom 
or right and left (Options vary based on the type of scanner) of 
the edge of the image.  This is used to reduce possible corner 
clipping on the skewed images and often applied to a batch of 
skewed document to be scanned in the auto document feeder.  
Select a value between 0 and +5 mm.   Note the overscan 
result will not be shown in the Display window and that the 
availability of the function varies based on type of scanner.  
 
 
Multi-Feed Detection    

Multi-Feed Detection allows you to detect overlapped document 
that go through the auto document feeder.  Multi-Feed usually 
occurs due to stapled documents, adhesives on documents, or 
electro-statically charged document.  Note： The availability of 
the function varies based on type of scanner. 

Additional Length Detection 

Additional Length Detection allows you to define the length of 
document being multi-fed.  This value indicates the additional 
length exceeding your scan area.  The Display window will 
show the size of the document as you change the value.  A 
value of 0 indicates no additional length detection.  The 
Additional Length Detection is best used when scanning same-
size documents in the auto document feeder.   
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Example：Additional Length Detection：Set Additional 
Length to be 2.02 inches 
 

 
 
 

2.02” 
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Ultrasonic Detection 
 
Ultrasonic Detection  allows you to set overlapped document by 
detecting paper thickness between documents.  Note： The 
availability of the function varies based on type of scanner. 
 
 
There are two options available if Multi-Feed is detected.  

 Stop Scanning after Multi-Feed 

If this is selected, the scanner will stop the feeder and 
display the following Warning dialog box if multi-feed is 
detected. 

 

 

Action:   

1. Follow the instruction on the Warning dialog box to 
remove the rest pages on the feeder. 

2. Click OK to close the Warning dialog box. 

3. Scan the rest pages. 
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 Sound Alarm on Multi-Feed  

If a wave file is added, the scanner will make a sound 
alarm if multi-feed is detected yet no Warning dialog box 
will be displayed.   

If “Stop Scanning after Multi-Feed” is selected, the scanner 
will stop the feeder.   

If “Stop Scanning after Multi-Feed” has not been selected, 
the scanner will continue to scan till the end of your 
document. 

Action: 

1. If “Stop Scanning after Multi-Feed” is selected, follow 
the action described in the preceding section “Stop 
Scanning after Multi-Feed” on the previous page to 
complete your job. 

2. If “Stop Scanning after Multi-Feed” has not been 
selected, rescan the pages where multi-feed is 
detected. 

 

How to add the sound alarm： 

1.  Click the Browse button on the right side of the speaker 
icon. The Open dialog box appears.  

2.  Choose your wave file.  

3.  Click the Open button.  The wave file is added.  
 

Units 

Defines the primary measurement system.  Inches, 

Millimeters, and Pixels are available.  
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4.5.3 Relative to Document 

 
Relative to Document: (used for batches of same-sized 
documents) 

This option allows you to crop different areas on your 
documents and deliver these images in B&W, Gray, or Color 
separately.  For example, there are applications which require 
you to store the entire document in B&W and a part of the 
document in color to save storage space.  This is useful for 
documents where a photograph, or signature appears in a 
consistent area on the document such as resumes, and so on.   
 
The following procedure describes how to reproduce the entire 
document in B&W and a portion of document (picture) in color.   
 
1. On the Paper tab, choose “Relative to Document” or “Fixed 

to Transport” from the Cropping option. 

2. Choose your scan size from the Scan Area option.  The 
selected scan size will be displayed in a red rectangular 
box.  This is also the scan size of your entire document. 
(For example, ISO B5.  If you have not chosen a scan area 
and leave the selection as None, then the default area will 
be the scanner’s maximum.)  

 

1 

2 A red 
rectangular 
box 
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3. Click the Preview tab to display the Preview window.  A 

black rectangular box appears to indicate the max. scan 
size your have just selected. 

 
 
4. Click the Preview button to view the entire image in low 

resolution to correctly crop your relative scan area.  

 

5. Select image type from the Image Selection box.  The 
selected image will appear in highlighted color. (For 
example, Front Color) 

6. Place your cursor on the Preview window and click your 
left mouse button.  A cross sign will appear as illustrated.  
Create your relative scan size diagonally by dragging the 
left mouse button to your preferable size.  The selected 
area will appear in a red box as illustrated.  

A black 
rectangular 
box 

The selected 
image  

The Preview 
Image 

The Preview 
Button 

The Image 
Selection 

Box 
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7. Check the B&W image from the Image Selection box to 
scan the entire document. 

8. Click the Scan button to start scanning the document in 
two image types and sizes.  (See the result in below.)  

   
   The entire document in B&W     The relative area in color 

 

The 
Relative 
Area  

A Cross 
Sign 
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4.6 The Preview Tab 

 
The Preview tab allows you to preview (a low-resolution scan) 
your image before final scan.  This preview image lets you 
allocate your scan area.  You can choose your scan area by the 
“Scan Area” drop down list box or placing your cursor on the 
Display window and dragging it diagonally on the Display 
window.  Then, a red rectangle box will appear to indicate the 
selected area. 
 
Note:  If you choose “Automatic Cropping” on the “Paper Tab”, 
then to select a scan area on the Preview tab is not allowed. 
 

 
 

The Preview Tab 
 
 
 

The Display 
Window 
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4.7 The Options Tab 

The Options tab allows you to set following additional image 
processing settings.   
 

 

The Option tab dialog box 
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Flip Side 
Rotation 

Select “fanfold” to rotate the image 
of the reverse side to 180 degrees.   

This is applied to double-sided 
document which are viewed in 
portrait are sometime fed into the 
scanner in landscape or vice versa.   

Choice: Book, Fanfold. 

If “Book” is selected, the image of 
the reverse side will not be rotated.  

 
The following illustration shows the documents which should 
be viewed in portrait are fed into the scanner in landscape 
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Rotate Image Choose the rotation angle from the 
drop down list if you wish to rotate 
your scanned image. 

Choice: None, 90°CW(clockwise), 
90°CCW(counter clockwise), 
180°. 

 

 

Original  
Rotate 90°CW 

 
Rotate 
90°CCW 

 

 

Rotate 180° 

 
 

Blank Page 
Removal 

Check if you wish to remove the 
blank page and move the slider to 
the left or right to your desired 
threshold.   



 User’s Manual 

 4-39

 
 
Edge 
Fill 

Check White or Black if you wish to add white or 
black edge on the border of your scanned 
image. Enter the value from 0 to 5 mm.  Default 
value is 0. 

 
Original 

 
Edge Fill: 5mm (Black) 

 
Image 
Control 
Option 

Check the Mirror box if you wish to reverse the 
right and left side of your image. 

 
Original 

 
The Mirror Effect  
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Background 
Setting 

This option allows you to set your scan 
background. 
Choice: White Background, Black 
Background. 
 
*This option varies based on type of scanner 
and is available for the front page in the ADF 
(auto document feeder) only.  For the rear 
page, only the white background is 
available.   
 

 
White Background 

 

 
Black Background  
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4.8 The Setting Tab  

The Setting tab allows you to set the following settings: 

 

 

The Setting tab dialog box 
 
Energy Saving 
Control 

Check the Enable Energy Saver box 
and move the slider to the right to set 
the amount of time to start the energy 
saver after your last action. The range 
is from 1 to 240 minutes.  The default 
is 15 minutes. 
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Batch Scan 
Setting 
 

•Batch Scan 
To increase the scanning speed, the 
scanner first scans a few pages of your 
document and then sends these scanning 
data to the application.  Therefore, during 
scanning, the numbers of pages been 
scanned on the scanner is somehow 
different with the numbers of pages 
displayed on your computer screen.  
Choose this mode if you wish to complete 
your scanning task at the fastest speed. 
 
•Page Scan 
If you choose Page Scan, during scanning, 
the scanner will first scan only one page of 
your document and then send the scanned 
data to the application and then scan the 
next page and send the next data to the 
application, and so on.   Therefore, in this 
mode, the scanning speed is slower yet this 
helps to keep the same scanning progress 
between the scanner and your computer 
screen. 

 

Barcode 
Detection 

Check this option to enable detecting and 
recognizing barcode in your document. 
After the detecting process, an 
avbarcode.ini file will be generated and 
stored in your system drive, for example, 
Windows\avbarcode.ini.  
Note:  The availability of this feature varies 
based on type of scanner. 
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Show Scanning 
Progress 

Check and the scanning progress bar 
will be shown during scanning. 

Show Warning 
Message 

Check to show the warning messages 
such as “ADF pad count exceeds 
50,000 scans (the number varies based 
on type of scanner). Please replace the 
ADF pad and reset the pad count.” 

Save Settings 
after Closing 

Check to save your scanner properties 
settings after leaving the dialog box.  
Next time when you open the Scanner 
Properties dialog box, the previously 
saved settings will be shown. 
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4.9 The Information Tab  

The Information tab displays the following system and scanner 
information.  

 
 

The Information tab dialog box 
 
 

The “Report” button： 

If you encounter any error message while using the scanner, 
click the Report button.  A report.txt file (C:\AVxxx) will be 
generated.  Please send this file to the nearest service center 
for trouble shooting.   
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The “Reset Pad Count” button」： 

After scanning approximately 50,000 pages (the number varies 
based on type of scanner) through the Auto Document Feeder 
(ADF), the ADF pad may be worn out and you may experience 
problems with document feeding.  In this case, it is highly 
recommended to replace the ADF pad with a new one. (Please 
refer to the manual for proper replacing procedure.)  For 
ordering the ADF pad, please consult your nearest dealer.  
After replacing the ADF pad, click the “Reset Pad Count” 
button to reset the pad count.  

 

The “Reset Roller Count” button」： 

After scanning approximately 200,000 pages (the number 
varies based on type of scanner) through the ADF, the ADF 
roller may be worn out and you may experience problems with 
document feeding.  In this case, it is highly recommended to 
replace the ADF roller with a new one. (Note the replacement 
of the ADF roller has to be performed only by authorized 
service center.  Therefore, please return your scanner for roller 
replacement.)   After replacing the ADF roller, click the “Reset 
Roller Count” button to reset the roller count.   

Note： 
The lifetime and the replacing procedure vary based on type of 
scanner.  Please consult your nearest dealer for more details.   
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5. ISIS Interface Operation 
 
 
The ISIS driver operation method is similar to the TWAIN’s. 
Every function on the ISIS interface screen is briefly described 
as below: 
 

 
 
 
Mode: Select one of scan modes, including B&W, gray, color 

options. 

Dither: 5 halftone levels available, can be disabled. 

Dots per inch: Select your desired resolution. 

Paper Size: Select your desired paper size. 

Brightness: Adjust your scan image brightness or darkness. 

Contrast: Adjust the range between the darkest and the 
lightest shades in the image. 

Default: Click to reset all settings. 

Area: Select your desired scan area or position. 
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6. Maintenance 

6.1 Cleaning the ADF  

The scanner is designed to be maintenance free.  However, 
it still needs to be cleaned occasionally to ensure optimum 
image quality and performance. 
 
From time to time the pad assembly and feeding rollers 
may become contaminated with ink, toner particles or 
paper dust.  In this case the scanner may not feed 
documents smoothly or several documents may feed at 
once.  If this occurs please follow the cleaning procedures 
to return your scanner to its original state.  

 

The cleaning procedures  

 

i). Moisten a cotton swab with isoprophyl alcohol (95%).  
(Cleaner kits are available from PictureVision.) 

ii). Carefully open the ADF to the left .  Wipe the feeding 
rollers by moving the swab from side to side.  Rotate 
the rollers forward with your finger and repeat the 
above cleaning procedures until the rollers are clean.  
Be careful not to snag or damage the pick springs. 

iii). Wipe the pad in the direction from top to bottom.  Be 
careful not to hook the pick springs. 

iv). Close the ADF unit.  Your scanner is now ready for 
use. 
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ADF Roller 

ADF Unit 

ADF Pad 
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6.2 Cleaning the Glass 

 

The procedures: 

i). Soak a cotton swab with some isoprophy alcohol 
(95%). 

ii). Open the ADF unit and document cover as shown in 
Figure 6-2.  Wipe the glass of flatbed area and ADF 
area by moving the swab from side to side. 

iii). Close the ADF unit and document cover.  Your scanner 
is  
now ready for use. 

 

 
 

Figure 6-2  The Cleaning Area 

Glass 
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6.3 Replacing the ADF snap-in pad module 

 
 
After scanning approximately 20,000 pages through the 
ADF, the separation pad may be worn out and you may 
experience problems with document feeding.  In this case, it 
is highly recommended to replace the pad module with a 
new one.  For ordering the pad module, please consult your 
nearest dealer and follow the procedure below to replace it.  
 
Disassembling Procedure 
 
1. Open the ADF cover. 

2. Remove the ADF snap-in pad module by pulling out 
the upper part of the pad clamp as shown in Figure 6-
3. 

 
 
 

 

 
 

Figure 6-3 Remove the ADF Pad 
 

A.  ADF Pad 
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Assembling Procedure 

 
 

1. Take out the ADF pad module from the box. 

2. Hold the upper part of the pad clamp and place it 
gently to the pad holder as shown in Figure 6-4. 

 
 
 

      
 

Figure 6-4 Installing the ADF Pad 
 
 

A.  ADF 
Pad 
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6.4 Replacing the ADF Paper Feed Roller 

 
 
1. Open the ADF cover. 
 

 
 
 
2. Lift the tabs. 
 

 
 
 

ADF cover 

Tab 
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3. Remove the paper feed roller cover. 

 

 
 

 
4. Remove the paper feed roller. 
 

 
 

 

ADF roller 
cover 

ADF paper 
feed roller 
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5. Insert the new paper feed roller by aligning the tabs 

into the slots and pressing the roller into place. 
 

 
 

 
6. Reinsert the paper feed roller cover and snap it into 

place. 
 

 
 

7.  Close the ADF cover. 

 

Slot 
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7. Trouble shooting 
 

The scanner will automatically perform a simple self-test 

each time it is turned on.  This will help spot major system 

errors in the scanner itself. 

When the test is initiated, the READY LED is flashing.  When 

the test is completed, if no error occurs, the READY LED is 

steadily on. 

If you have problems with the operation of your scanner, 

please check the following troubleshooting hints.  

 

7.1 Question and Answer 

Question:  The LED indicates that the scanner is ready, 
but the scanner does not respond to the 
scan command from the host computer. 

Answer:  a) Please check if the signal cable is firmly 
seated, and invoke the scan command 
again.  If there is still no response, please 
reset the scanner by turning it off and then 
on again, and reboot your host computer as 
well. 

  b) Check if the driver is correctly installed.   

 

Question:   Paper becomes jammed during scanning. 

Answer:  a) Open the ADF unit. 

 b) Pull out the jammed paper carefully. 
  c) Close the ADF unit. 
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Question:  More than one sheet of paper were fed into 

the scanner. 

Answer:  a) Open ADF unit. 

  b) Remove the multi-fed sheets of paper. 

  c) Close the ADF unit. 

  d) Flatten the corners and edges; loosen the 
paper before reloading it in the paper 
guide. 

e)  Check the feeding roller condition and 
do the cleaning if necessary.  

Question:   Paper becomes skewed in the scanner. 

Answer: a) Check the feeding roller condition; do the 
cleaning if necessary.  

  b) Use the paper guide when feeding the 
paper. 

Question:  When I power on the scanner, it makes 

noises and will not stand ready. 

Answer:  There are two possibilities: 

  a) You forgot to remove the shipping switch 
from the scanner.  Please remove the 
shipping retainer first. 

  b) You did not place the scanner on a flat 
desktop surface.  This may cause the 
scanner to function improperly. 
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Question:  When I power on the scanner, the lamp 

does not light. 

Answer:  The possibilities are as follows: 

  a) The lamp is out of order.  In that case, 
contact your authorized local dealer to 
change the lamp.  The life time of the lamp 
is about 5000 hours.  

b)  Check whether the power LED on ADF 
cover steadily lights or not. 

If it flashes, the power adapter malfunctions 
or the main board is short-circuited.   

Contact your authorized local dealer to 
replace the power adapter or main board. 

  
Question:  Getting image from the scanner is not a 

problem, but when scanning, the scanner or 
system will often crash. 

Answer:  Please check  

  a) If the SCSI cable or the USB cable is 
firmly seated; 

 b) Only two SCSI terminators can be connected 
to your SCSI daisy chain.  One is at the end of 
the SCSI device, and another is already in your 
host adapter. 

 

Question:  The scanned image always comes out to be 

too dark. 

Answer: a) Use your application to modify the 
Gamma setting to 2.2 and 1.8 for your 
printer and monitor respectively. 

b)  Use Brightness setting from the TWAIN 
user interface to get a brighter image. 
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Question:  The scanner works well otherwise, but for 

the line art, the lines scanned seem much 
thicker than those of the original. 

Answer:  Use the Brightness or Threshold setting to 

adjust the line art image.  
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7.2 Paper Jam in the ADF 

In the event of paper jam, please follow the procedures 

below. 

i). Open the ADF cover as shown in Figure 7-1. 

ii). Pull the paper out of the ADF unit carefully. 

 

 
 

 

 
 

Figure 7-1  ADF Paper Jam - Removing the Paper 

 

ADF Unit 

Document 
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8. Technical Service 
 
 
 
Technical support for Avision scanner is provided at Avision 
Technical Assistance Center (ATAC).  Before contact with 
ATAC, please prepare the following information. 
 
• Scanner serial & revision number (located on the 

bottom 
of the scanner) 

• Hardware configuration (e.g., your host CPU type, RAM 
size, free disk space, display card, interface card, etc.) 

• The name and version of your software application 
• The version of your scanner driver.  

Please call us at: 

US and Canada Area:    Avision Labs., Inc. 
 

Address: 6815 Mowry Ave. Newark CA 94560, USA 
Telephone: +1 (510) 739-2369 
Fax number: +1 (510) 739-6060 
Web Site: http://www.avision.com 
E-mail: support@avision-labs.com 

Other Area:    Avision Inc. 
 
Address: No.20, Creation Road I, Hsinchu Science 

Park, Taiwan, R.O.C. 
Telephone: +886 (3) 578-2388 
Fax number: +886 (3) 577-7017 
Web Site: http://www.avision.com 
Email: service@avision.com.tw 
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9.  Specifications 
 
 
Model Number 

300500001 

300500002 

 

(Simplex Scanner) 

(Duplex Scanner) 

Scanning Mode B&W 
Gray  
Color  

Optical 
Resolution 

600 x 600 dpi  

Light Source Cold Cathode fluorescent lamp 

ADF Capacity 50 sheets 

Scan Area Flatbed: up to European A4  

(8.5” x 11.69”) 

ADF: 3.7” x 5.5”(Min) 

ADF: 8.5” x 14”(Max) 

Interface SCSI-2/USB 2.0 

Power 
Requirement 

24Vdc/2A 

Power 
Consumption 

< 48 watts 

Operation 
Temperature 

5°C to 35°C 

Storage 
Temperature 

-40°C to 60°C 

Dimension 567 x 350 x 199 mm 

Weight 7.2 kg (15.87 lbs)  

 




